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Trident is a powerful scanning software package for
your flatbed or drum scanner. With its many flexible

features, Trident enables you to perform complex color
corrections and to make professional CMYK color separa-
tions from your scanned images quickly and easily.

Because it manipulates 36-bit color data or 12 bits per
color directly on the host computer, Trident gives you the
opportunity to preview changes during the initial scan-
ning process without additional prescanning. Trident also
provides instant CMYK feedback on your image transfor-
mations, so you can see the results of your changes
immediately.

Trident is available in two configurations:

Photo Edition (PE) package.

Separator Edition (SE) package.

Both packages are described this User Guide.

Trident Photo Edition (PE)

Photo Edition (PE) is Trident’s basic high-end scanning
package. The color engine used in PE is based on density-
to-reflectance calculations. Although the PE color space is
intended for photographers, photo retouchers, and those
who prefer working with RGB values, Trident PE provides
extremely accurate RGB-to-CMYK conversion with the
ColorSync feature. In addition, you can perform grayscale
and line art scans with Trident PE.

Trident PE features include:

Multiple, independent scan regions.

Color, range, and gradation control for individual scan
regions.

Image manipulation tools, including rotation, crop-
ping, and unsharp masking.
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Selective color.

Eyedroppers.

Flexibility in setting lpi, dpi, size, and scale for individ-
ual scan regions.

Ability to open TIF files for corrections.

Scanning to commonly used file formats.

Trident Separator Edition (SE)

Separator Edition (SE) is the Trident high-end scanning
software package based on a density-to-dot color engine.
This software is intended for use by those who under-
stand the concepts behind color separation and reproduc-
tion as they relate to offset printing.

The SE package offers sophisticated, advanced features
for creating high-end color separations, including:

Selective color correction.

Adjustments for wanted and unwanted colors.

Two operation modes for general production and
expert work.

Input/output three-color and four-color density range
gradation control.

Cast correction with diffused highlight and shadow
settings.

Gray Component Replacement (GCR), Undercolor
Removal (UCR), and gradation control.

User definable dot gain.

User definable gray balance.
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About This User Guide

This guide explains how to install and work through the
functions of the Trident software package. It contains all
the information you need to begin using Trident PE or SE
with your flatbed or drum scanner.

Once you have installed the software (as described in
Chapter 1), this guide will help you understand the process
and tools for scanning, color correction, and image
m a n i p u l a t i o n .

Chapter 2 provides overview information. Trident PE is
described primarily in Chapters 3 through 5. Additional
information is detailed in Chapters 6 and 7 for Trident SE.
Chapter 8 provides procedures for scanning to disk.
Chapter 9 presents “tips and tricks” for using the Tr i d e n t
s o f t w a r e .

Typographical Conventions
The following typographical conventions are used
throughout this guide.

Screen dialogs or windows are the displayed forms on
which you will enter information and select buttons to
perform actions.

The descriptive title of a window is shown within text
with an uppercase letter: Preferences window.

Fields are areas on a window where you enter infor-
mation.

Menus and menu options, window selections, on-
screen messages, and keyboard keys appear within
the text in bold: Manual Update, Preview, etc.

Special notes are highlighted with this notation:

Note: Provides information about the current
topic.
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Related Documentation

This guide assumes that you are familiar with your scan-
ner, computer operating system, and interface.

For detailed information about your computer, refer to
your computer’s installation guide. For details on using
your flatbed or drum scanner, refer to the user guide pro-
vided with your specific model.
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This chapter describes the configuration requirements
for Trident and guides you through the software

installation process.

Configuration Requirements

Before installing Trident, make sure your system meets
the following minimum configuration requirements.

Host Computer
In order to take full advantage of the Trident software,
your host computer must include the following for either
a Macintosh or PC system.

Macintosh Requirements

Power Macintosh 8100 computer or better with float-
ing point coprocessor installed.

24-bit color display adapter.

17" or larger high-resolution monitor (1024 x 768 dpi).

48 Mb RAM available (recommended: 64 Mb or more).

System 7.5.3 or higher.

Enough disk space to accommodate your scans.

PC Requirements

486 Personal Computer, 66 Mhz or better.

24-bit color display adapter.

17" or larger high-resolution monitor (1024 x 768 dpi).

SCSI I or II host adapter.

48 MB RAM available (recommended: 64 Mb or more).

Windows 95 or NT 4.0  or higher.

200 Mb disk space minimum.
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Scanner
Trident works with a variety of flatbed and drum scanners
from Howtek. For details on connecting your scanner to
your host computer, refer to your scanner’s user guide.

Setting Up and Installing Trident

Before beginning the installation process, make a copy of
your Trident diskette. Store the original diskette in a safe
place and use the copy for installation.

Configuring Your Monitor for Trident
To configure your monitor for Trident, follow the steps
below for either a Macintosh or PC system.

Macintosh Monitor Configuration

1. Open Control Panels on the Apple menu.

2. Open the Monitors control panel and set your monitor
to millions of colors.

Figure 1–1
Macintosh: Monitor
Settings

Millions
Setting
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PC Monitor Configuration

1. Open Settings on the Start menu.

2. Open the Control Panel and select Display.

3. Select the Settings tab and set your monitor for 
True Color (24-bit) and your resolution as 1024 by 768
pixels.

Figure 1–2
PC: Monitor Settings

True Color
(24-bit) 1024 x 768

Resolution



1-4 Trident User Guide

Installing the Software Access Key (Dongle)
To install the software access key (dongle):

1. Shut down your computer.

2. On a Macintosh, install the dongle between your key-
board and CPU.

On a PC, install the dongle to your printer port.

Note: Trident can be used without the dongle,
in Demo mode, but you will not be able to save
final scans to disk. When the application starts
up without a dongle, a message appears indi-
cating that you are not authorized to use the
software.

3. Restart your computer.

Now you are ready to install the Trident software.

Installing the Trident Software

Note for Macintosh Users: If you are upgrad-
ing from a previous version of Trident, before
launching the application delete the Trident
Preferences file (located in the Preferences
folder within the System Folder ). Trident will
create a new preferences file the first time you
launch it.

Note for PC Users: If you are upgrading from
a previous version of Trident, before launching
the application uninstall the previous version.
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To install the Trident software:

1. Insert the Trident CD into your CD-ROM drive. 

Note for Macintosh Users: If you want to
change the location in which Trident will be
installed, follow these steps:

Click on the Install Location pulldown
menu. 

Select Select Folder in the pull-down 
menu. 

In the destination window that appears, 
select the destination disk and folder of 
your choice for Trident. Trident software 
requires at least 3 MB of hard disk space.

Highlight the folder where Trident will 
reside and click on Select.

Note for PC Users: If you want to change the
location in which Trident will be installed, refer
to Step 2 below.

2. On a Macintosh, double-click on the Installer icon.

On a PC, open the Start menu and select Run. In the
Open field, enter the path (or Browse to locate) of the
Setup.exe file on the CD. For example, if your CD drive
is “D” enter:

D:\setup.exe

Click OK to initiate the installation program.

3. Complete the installation by following the instructions
on your screen. Be sure to review the entire license
agreement. You must agree with the license before
proceeding.
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Macintosh Users Only:
Assigning Memory to Trident
To increase the amount of memory assigned to Trident:

1. Select the Trident application icon in the Trident folder
and choose Get Info from the File menu.

2 . In the Trident Info window that appears, under
M e m o ry Require m e n t s make sure the P re f e rred size i s
set to at least 32 Mb. If possible, increase the RAM for
Trident to 64 Mb.

3. Close the Trident Info window.

Figure 1–3
Trident Get Info
Window
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Trident provides a powerful and flexible software inter-
face between your computer and your flatbed or drum

scanner. The software offers a wide array of professional
scanning and image manipulation tools with all the con-
venience and user friendliness of your standard computer
interface, including pull-down menus, multiple windows,
point-and-click controls, and keyboard shortcuts.

Launching Trident

To launch the application, double-click on the Trident
icon. When the application opens, the menu bar, button
b a r, tools, blank Overview window, and Queue Manager
are displayed.

Menu Bar and Button Bar
You can access all Trident commands and functions
through options on menus.

Buttons duplicate options available on menus
and provide a convenient way to access most
Trident features.

Figure 2–1
Trident Menu Bar

Figure 2–2
Trident Button Bar
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Tools (Controls)
The tools provide information about parameters and set-
tings.

Overview Window
The Overview window is the area in which you will pre-
view images. This window adjusts in size automatically to
match the drum that is mounted.

Queue Manager
The Queue Manager is the area in which you will queue
the Overview image and regions that you have defined.

The Queue Manager is a flexible tool designed to orga-
nize your work with regions. Use the Queue Manager to,
activate a region, preview regions, rearrange the order of
the regions, and scan regions to disk.

The Queue Manager is a multitasking tool. While a region
is being previewed or final scanned, other regions can be
added, deleted, or rearranged in the Queue Manager.
Color correction work can also be performed on a region
in the queue, whether or not scanning is in progress.

The Queue Manager window can be manipulated using
standard computer-system window tools. (Refer to your
operating system documentation, as necessary.)

Figure 2–3
Trident Tools

Figure 2–4
Queue Manager
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Setting Preferences

Before you begin scanning, check the Trident preferences
to be sure the options you need will be available.
Preferences are set on the Preferences window. To open
this window, select Preferences on the Trident Edit menu.
The Preferences window consists of two windows,
accessed with the General and Other tabs.

Note: The preferences you select, as well as all
window positions and contents, are saved by
Trident when the application is closed. The next
time you launch Trident, they will be restored.

General Tab Settings
The General tab area of the Preferences window provides:

Application
Software revision number and type of encryption (if
any). You cannot edit these fields.

Figure 2–5
Preferences Window:
General Tab
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Default Save Director y
Directory where final scans are stored. Click on the
Change… button to define the desired location.

Queue
Options to prompt before files are added to the queue
for final scan or to periodically save the queue. If you
periodically save, enter a time interval (in seconds).

Other Tab Settings
The Other tab area of the Preferences window provides:

Overview
Control of how images are viewed on screen during
the scanning and color correction process.

The R e s o l u t i o n setting defines the desired resolution of
the Overview scan. The default value is 50 dpi. Higher
resolutions provide greater detail in the image window,
but also require considerably more time and RAM (as
reflected in the non-editable Buffer Size field). If you
have over 64 MB of RAM available for Trident, setting
the resolution to 7 5 or 1 0 0 increases the default resolu-
tion in the region windows, which may save you from
the need to perform a preview scan for each region.

Figure 2–6
Preferences Window:
Other Tab
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The Preview Size setting defines the length and width
of the image window. The default size is 512 pixels.

Units
Units of measure for the entire application. The avail-
able options are Pixels, Inches (default), Centimeters,
Millimeters, and Points. Note that the Line Screen and
Sampling tools are disabled (grayed) when Pixels is
selected.

Interpolation
Method by which Trident determines how new pixels
are added when a non-native resolution is used.

Bi-Cubic: Weighted average of a region of pixels
around the target pixel (default mode). This type of
interpolation provides high quality for continuous
tone images when scaled to a non-native resolution
or to a resolution higher than the maximum optional
resolution of the scanner.

Bi-linear: Weighted average of adjacent pixels. This
setting provides high quality with better performance
than Bi-Cubic, but may cause unwanted patterns in
some images.

Nearest neighbor: Interpolation by pixel replication
(should only be used for line art).

Probe Size
Size of the area sampled by the probe. 1x1 samples a
single pixel; 3x3 samples the eight pixels surrounding
the cursor location; 5x5 samples the 24 pixels sur-
rounding the cursor location.

Auto Update
Control to automatically update images each time a
change is made. If this option is not selected, you can
update the image preview manually.

Highlight/Shadow Probe
Allows the pixel values window to be displayed when
a cursor is placed over the Sticky Densitometers.
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Changing Screen Gamma

The Trident Monitor Setup option on the E d i t m e n u
enables you to specify the gamma values of your monitor.
This will affect the way in which previewed images are
displayed on your screen. The Monitor Setup window for
Trident PE is shown in Figure 2-7. The window for Tr i d e n t
SE is shown in Figure 2-8.

Figure 2–7
Trident PE: Monitor
Setup Window

Figure 2–8
Trident SE: Monitor
Setup Window
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By default, Trident assumes that your monitor is factory
set to a screen gamma of 1.8. If you have changed your
monitor’s gamma, enter the new gamma value in the
Monitor Setup window. Trident then adjusts its previews
to look the same regardless of any monitor gamma (in
the range of 0.2 to 5.0)

Target Gamma
Enables you to separately adjust each individual color
channel for the display of the preview data.

Note: Trident does not adjust the gamma value
of your monitor. It merely adjusts its previews
to look the same regardless of different gamma
settings.

Trident PE Output Gamma
Controls the gamma for the RGB data in the file.

With Trident SE, two options are provided to preview
CMYK images on your RGB monitor:

Trident SE CMY to RGB
Provides a list of preset tables from which to choose.
Your selection depends on your CMYK output press.

ColorSync Profiles
Enable you to set output and display profiles for
ColorSync--a method used to calibrate the input
device (scanner), display device (monitor) and output
device (imagesetter, printer, film recorder, etc.) to the
same independent color space for accurate display
and output.

The ColorSync feature (available for Mac users only)
enables you to view the prescanned image data on the
monitor as calibrated data and scan an image into a
different color space (such as RGB to CMYK conver-
sion). This feature utilizes the Apple ColorSync Color
Management Architecture which is based on the
International Color Consortium (ICC) device indepen-
dent profiles.
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Note: You must have ColorSync 2.0 or later
loaded in your Mac OS to use the ColorSync
Menu in Trident. Generic profiles can be supplied
by the device vendor or you can create custom
profiles using many third party software pack-
ages. These device profiles must be installed
into the ColorSync Profiles Folder, found in your
Mac System folder, for Trident to find them.

Select Output Profile displays all the output device
profiles that are loaded in your ColorSync Profiles
Folder. If you select a CMYK Output Profile, Trident
will generate a scanned image as a CMYK TIF file.

Select Display Profile displays all the output device
profiles that are loaded in your ColorSync Profiles
Folder.

Refer also to the description titled, ColorSync: Using
the ColorSync Feature (Mac Only), in Chapter 4.
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Using Basic File Tools

Under the File menu, basic file tools are available:

Open
Opens an existing TIF file.

Save
Saves the currently open file. This opens the Save As
window. However, this option is used only for nam-
ing, file location, and/or change file type.

Save Queue
Saves the scan queue to a file. The Overview window
is not displayed when you select this option.

Quit
Ends your work with the Trident application.

The New, Close, Save As, Revert, Page Setup, and Print
options are not applicable.

Using Editing Tools

The Edit menu provides basic editing tools:

Undo and Redo
Reverses the last action. A “redo” reverses an “undo.”
Trident enables you to perform multiple “undos”  or
“redos” by repeatedly selecting Undo or Redo.

The C u t, C o p y, P a s t e, and C l e a r options are not applicable.

Note: All other menus and options are
described in the remainder of this book.

Figure 2–9
File Menu on the
Trident Menu Bar

Figure 2–10
Edit Menu on the
Trident Menu Bar
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This chapter provides an overview of the scanning
process.

Overview of the Scanning Process

Preparing scans with Trident is a simple process with
many tools for an efficient and organized workflow.
Summarized below are the basic steps in the Trident
process:

Step 1:
Generate an Overview scan (preview) of the entire
scanning surface. This image will appear in your
Overview window and as the first image in the Queue
M a n a g e r.

Step 2:
Define regions as desired and add them to the Queue
Manager.

Step 3:
Select an image from the Queue Manager and per-
form the desired image corrections while verifying the
results visually and numerically on-screen. 

Step 4:
Scan the final images to disk using the desired output
and file formats.

With the exception of the procedures for correcting
scanned images and scanning to disk, each step in the
scanning process is described in this chapter.

For details on correcting scanned images with Trident PE,
see Chapters 4 and 5. In addition, see Chapters 6 and 7
for Trident SE.

Procedures for scanning to disk are provided in Chapter 8.
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Step 1:  Generate an Overview Scan

Before working with images, the contents of the scanning
surface must be scanned into the Overview window.

1. Mount the original(s) on your scanner (see the scan-
ner user guide for details on how to mount originals).

2. Select the Scan Type in the tools:

The available options are:

Transmissive
Color or black-and-white transparencies.

Transmissive (Negative)
Color or black-and-white transparencies that will
be viewed in the Overview window as negatives.

Reflective
Color or black-and-white photographs, artwork, or
prints.

3. Click on the Preview button ( ) below the blank
Overview window in the Queue Manager.

Your scanner will produce a low-resolution Overview
scan of the entire platen or drum surface. This will
display in the Overview window.

Note for Mac Users Only: 
To stop an Overview scan once the desired por-
tion of the scanning surface has been scanned,
press the Command and period keys.

Figure 3–1
Trident Tools

Scan Type
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Checking Tool Parameters
As you scan, you may want to check the following para-
meters in the tools. Ultimately, you will want to make
sure they match your final scan specifications.

The lock/unlock feature is available on several parameter
settings. This enables you to lock ( ) or unlock ( ) the
setting, unless noted otherwise in the descriptions below.

Region
Region with which you are currently working.

Scan Type
Original media type on the scanner: Transmissive
(Positive), Transmissive (Negative), or Reflective.

Scan Mode
Output mode for the scanned image. The options are:

CMYK: (Trident SE only) Standard Cyan, Magenta,
Yellow, and Black.

RGB: Standard Red, Green, and Blue.

Gray Red/Green/Blue: Grayscale image from the Red,
Green, or Blue color channel, respectively.

Line Red/Green/Blue: Line art from the Red, Green, or
Blue color channel, respectively.

Note: You should use Gray Green or Line
Green for most grayscale or line art. If your art-
work is predominantly red or blue, you may see
improved results by selecting the Red or Blue
option.

Black: Composite of RGB into grayscale. This mode
(which is available with Trident SE only) has dot gain
applied and diffused highlight.

Line Screen
Number of lines per inch in a halftone image. Along
with Sampling (see below), the line screen is used to
calculate the final scan output resolution.
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You can click on the small black lock icon next to the
Line Screen field to lock the scanner’s resolution at
the next highest native resolution. When locked, the
scanner’s native resolution is used; when unlocked,
the final scan output resolution is based on the values
in the Line Screen and Sampling fields. To unlock the
resolution, click on the black lock icon again.

Sampling
Refers to the theory of sampling ratio. This is the
number of dots per pixel in the final scanned image.
Most files for the printing industry are created as 1.5
to 2 times the line screen.

The Sampling value multiplied by the Line Screen
value (see above) yields the dots per inch (dpi) resolu-
tion of the final image. For example, a Sampling value
of 2 with a Line Scre e n of 150 results in a 300 dpi image.

Note: If sampling is set to 1.0, the value entered
into the line screen will be the resolution (DPI)
of the final scan.

File Size
The amount of disk space the final scan requires. You
cannot edit this field. As you adjust other scanning
parameters (Line Screen, Sampling, Scale), the value in
this field changes.

Note: The Mac has a 4 Gb file size limitation.

Width and Height
Specific width or height for your final image. However,
based on the cropped area, the width and height are
proportional to each other. Any change in the Width
value proportionally changes Height and vice versa.

You can click on the black lock icon next to the Width
or H e i g h t field to lock the final file size width or height.
If both locks are selected, the crop box is restricted to
an aspect ratio defined by the values entered into the
Width and Height fields.
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Scale
Degree of enlargement (or reduction) of your final
image. Remember that file size is directly proportional
to the scale of your image.

Note: If you are scanning all the images in the
queue using the same line screen, sampling,
and scale values, set up the Overview with the
desired values. All images subsequently added
to the queue will reflect those changes.

Note: For the Overview scan, all parameters set
in the tools and tool menu will carry into each
new region defined. To improve consistency and
workflow, it is recommended that you set up
these parameters in the Overview scan and then
add regions rather than setting them up for
each region separately.

Step 2:  Define Regions

A region is an area of the Overview that you will define
and use to preview, manipulate, and prepare as a final
scan. When you create regions, they are placed in the
Queue Manager which is a highly flexible tool designed to
activate, preview, and organize your work with regions.

This section explains how to:

Define a region.

Add a region.

Activate a region.

Preview regions.

Transform a region.

View a region in detail.

Rearrange regions in the Queue Manager.

Delete a region.
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A Note About Images and Computer Memory (RAM)

You can define any number of regions. However, you may
reach limitations based on the memory of your system
(PC) or the memory allocated to Trident (Mac).

The amount of memory (RAM) required for a region varies
depending on the Overview resolution (selected in the
Preferences window) and the size of the region. (The
default application RAM for Trident is 33 Mb.) If you
exceed the amount of memory by defining too many
regions, a warning appears. You can:

Final scan the regions you have already created (as
described later in this section) before creating addi-
tional regions and then delete these regions.

Delete unneeded regions (as described later).

Quit the Trident application and assign more RAM.

Defining a Region
Once you have produced an Overview, Trident’s image
selection tools (located in the button bar and as corre-
sponding options on the Command menu) enable you to
define and work with regions.

Probe Region
Used to select items and regions. This tool is also
used to move the cursor around within a region to
sample pixels for the probe readout.

Crop Region
Used to define a portion of the image.

Zoom +/-
Used to enlarge or reduce an image for more pre-
cise examination of a region. Click on the image
with the Zoom tool to enlarge the image. If neces-
sary, resize the image window to accommodate
the new view. The magnification is shown at the
bottom left corner of the image window.
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Note: The point where the Zoom tool is clicked
becomes the new center of the image in the
window.

Note for Mac Users Only:  To reduce the
view again, hold down the Option key while
clicking on the image with the Zoom tool.

Typically, you will use the Crop tool to define a region as
a cropped portion of the Overview.

Adding a Region
Click on the Add Region button ( ) or select Add Region
on the Command menu to assign the cropped area to a
region. The region appears as a new image in the Queue
Manager.

Note: You can only create new regions from
the Overview, not from another region.

After the image area has been defined with the Crop tool,
the region can be added to the Queue Manager in several
ways. For example, you can simply double-click inside the
cropped area. The following shows an Overview and two
regions in a Queue Manager.

Trident names regions by default according to the order
in which they are created. The default name assigned to a
region is based on the following scheme:

Figure 3–2
Queue Manager
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Region-X : scan####

where:

X = Region number in the order of its placement
in the Queue Manager.

#### = Arbitrary sequential number.

Your regions may represent separate originals for differ-
ent jobs, or different areas from within the same piece of
art. When you prepare your final scans, it is helpful to 
follow a naming convention for your regions that makes
sense in your production environment (for example, by
job, client, date, etc.).

To change the name of a selected region, select Save on
the File menu. Then, save the region with a different
name.

Note: For more information about naming
regions, see Naming Final Scans, in Chapter 8.

Activating a Region
To activate a region, double-click on its image in the
Queue Manager. The selected region is then framed in
green, the region number is displayed in the title bar of
the Overview window, and the image data is shown in
the appropriate fields in the tools.

A 1:1 view of the image is displayed in the Overview 
window. Color correction work can be performed on the
image, as described in Chapters 4 and 5 for Trident PE
and, additionally, Chapters 6 and 7 for Trident SE.

Note: When a region is cropped, added to the
Queue Manager, and activated, the resulting
image is at a low resolution. Regions derived
from small crop areas may appear blurry and
out of focus. The image quality on the screen
can be improved by previewing the region.
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Previewing Regions
Before manipulating and correcting regions, you should
preview each image.

Note: Although previewing a region is not
required, it improves the accuracy of the Probe
values and provides a higher resolution image
for image correction work. Without a preview
scan, your Probe values may not be accurate
due to the dithering of the low resolution image.

To preview a region, use one of the following tools, or
select the corresponding option from the Command
menu:

Preview
To preview a single region, click on the Preview
button ( ) under the desired image in the Queue
Manager.

Before a region has been previewed, the Preview
button is white. While the region is being pre-
viewed, the Preview button is red, green, and blue.
Once the preview is completed, the button changes
to all red.

Preview All
To batch preview all the regions in the Queue
M a n a g e r, click on the P review All button. Yo u
would use this feature once you have defined and
added multiple regions with the Trident tools. T h i s
can be done even if there are different types of orig-
inals in the scanning area (reflectives, positive
transparencies, or negative transparencies).

The scanner will scan each region in succession.

To preview only certain regions in the Queue
Manager, click on the white Preview button ( )
under each desired image. The regions are then
scanned in order.
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Interrupting the Preview

You can interrupt the preview scanning by using the
Active/Pause button ( or ) on the right under the
Overview in the Queue Manager. Click on this button to
toggle the scanning process on ( , green) or off ( , red).

Transforming a Region
To make your work with regions easier, Trident includes
tools to transform images. Corresponding options are
available on the Transform menu.

Note: The image transformation tools can be
used only in a region, not in the Overview.

Transform Left
Rotates the image in a region 90° counterclockwise.

Transform Right
Rotates the image in a region 90° clockwise.

Flip Horizontally
Flips the image horizontally along the vertical axis.

Flip Vertically
Flips the image vertically along the horizontal axis.

Viewing a Region in Detail
The Detail option on the Command menu is used to scan
a small area of a region at the input scan resolution (line
screen multiplied by sampling ratio multiplied by scale).
This feature is helpful for examining an image in precise
detail (for example, when checking unsharp masking or
descreening).

1. Activate the region in which you want to perform a
detail scan by double-clicking on it in the Queue
Manager.
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2. Click on the Pick Detail Point button ( ) or select
Detail on the Command menu. Move the cursor over
the image and it will become a crosshair.

3. Click on the center of the desired area of the image to 
be viewed in detail. The scanner performs a detail scan
of predefined dimensions around the point you select-
ed using the scanning parameters indicated in the
fields in the tools (line screen, sampling, and scale).

Once the detail scan is completed, you can switch
between the detail view (as indicated in the title bar of
the Overview window) and normal preview by uncheck-
ing the Detail checkbox in the Queue Manager (to the
right of the Progress indicator):

Rearranging Regions in the Queue Manager
You can reorganize the regions in the Queue Manager at
any time, even while scanning is in progress.

To rearrange the order of the regions in the Queue
M a n a g e r, click and drag the region to the desired location.

Deleting a Region
You can delete a region in the Queue Manager at any
time, even while scanning is in progress. To delete a
region, use one of the following tools, or select the corre-
sponding option from the Command menu:

Figure 3–3
Detail Checkbox

Detail Checkbox
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(black) Cut Region
To delete a single region from the queue, activate
the region by double-clicking on it and then click
on the black Cut Region button.

(red) Cut All Regions
To delete all regions from the queue (including the
Overview), click on the red Cut All Regions button.

Refer to page 2-9 for a review of all Save features.

Step 3:  Perform Image Corrections

Once you preview your Overview and add/review regions,
as desired, you are ready to select an image from the
Queue Manager and perform the desired image correc-
tions. You can do so while verifying the results visually
and numerically on-screen. 

A few commonly used image correction features are
described on the following pages. All other image correc-
tion procedures are detailed in Chapters 4 and 5 for Tr i d e n t
PE and, additionally, Chapters 6 and 7 for Trident SE.

Automatically Add Highlight and Shadow
Trident provides an Auto range feature to automatically
detect highlight and shadow.

Click on the Auto Range button ( ) on the button bar or
in the PE RGB Control window. Highlight and shadow is
automatically added.

If both the Highlight ( ) and Shadow ( ) buttons are
selected on the button bar, markers will appear on your
image indicating the points within the cropped area that
have been selected automatically as the highlight and
shadow. (Refer to Figure 3-4 on the next page.) These
markers are known as “Sticky Densitometers.”
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When you select the probe tool, activate a region and
move it over the Sticky Densitometer. A window will
appear displaying the values for that point.

A Sticky Densitometer can be moved by the click-and-
drag method using the Probe tool. As the Sticky
Densitometer is moved, the values in the display window
change. This can be helpful if you would like to override
the automatic settings.

Update Images
When you change a region or scanning parameters, the
image can be updated in the Region window so you can
visually gauge the effect of the changes. Image updating
is performed in two ways: automatically and manually.

Updating Automatically

If you want the Overview window to be updated automat-
ically, select Auto Update On on the Command menu. The
image is then updated every time you make a change. To
turn off automatic updating, select Auto Update Off on the
Command menu.

Figure 3–4
“Sticky Densitometer”
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Automatic updating is helpful in visually tracking changes
incrementally. However, it can add production time due
to the time needed to refresh the screen image after every
adjustment.

Note: Auto Update can be set to on in the
Preferences menu.

Updating Manually

With automatic updating off, click on the Manual Update
button ( ) in any window where it appears to update
the active region with all changes since the last update.

The manual update feature is particularly useful if you are
a more experienced scanner operator and only need to
check the Overview window from time to time.

Note: If you are using the manual update fea-
ture, the Overview window display is updated
only when you click on the Manual Update but-
ton.

For further information on how the Update button and the
PE Probe work, refer to Chapter 4.

Step 4:  Scan Final Images to Disk

Once you have completed color correction work on your
images (see Chapters 4 and 5 for Trident PE and, addi-
tionally, Chapters 6 and 7 for Trident SE), they are ready
to be scanned to disk. Refer to Chapter 8 for a description
of how to check final settings and scan your corrected
images to a file. Chapter 8 describes:

Reviewing scan settings.

Performing final scans.



C o r recting Images in
the RGB Color Space
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Trident offers many powerful features that allow you to
correct your prescanned images before the final scan

is made. For those who prefer to work in the RGB color
space, Trident’s Photo Edition (PE) package provides fast
and efficient tools to make image corrections.

This chapter explains how to use the PE tools and
describes how to use:

PE Probe

PE RGB Controls

Grayscale Controls

Line Art Controls

Trident’s unsharp masking (USM), descreening, and L*a*b
features are described in Chapter 5.

Note: Before making color corrections, make
sure the region you want to work on is active:
double-click on the region in the Queue
Manager.

At any time, you can click on the Update button to view
corrections.
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Using the PE Probe

The most important tool in correcting images is the PE
Probe. This window tracks your corrections by displaying
the RGB values. To view the Probe, select Probe on the
Tools menu.

As you pass your cursor over the Overview or a region
window, the Probe shows the values for the pixel(s) at the
current cursor position. The PE Probe window is divided
into four sections:

Probe Location
Shows the X/Y coordinates of the current cursor posi-
tion.

Figure 4–1
PE Probe
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Densities
Shows the original and output optical density values
for the selected pixel(s).

The original density value is not affected by changes
in the PE RGB controls. The output density is updated
after each change in the PE RGB control.

Before and After
When scanning in RGB mode, the PE Probe displays
the RGB reflectance values (RGB Pixel Values) for the
selected pixel(s).

If the image is in a grayscale scan mode (one of the
Gray options), the PE Probe shows the reflectance
value (Pixel) pixel both before and after correction.

When scanning line art (the Scan Mode is set to one
of the Line options), the Line Art Pixel Value field in the
PE Probe shows whether the selected pixel is black (0)
or white (1) both before and after correction.

Note: When probing images in line art or gray-
scale mode, set the Probe Size in the Prefer-
ences window to 1x1 to avoid false readings.

Static Probes
Shows the current status of the static probes that can
be placed on an image. The before and after color
corrections are indicated.

The location for each of the three static probes is set
by selecting the probe number ( ) and then placing
the cursor over the pixel that you want to monitor in
the image. The number icon is displayed on the
screen.

Note: Click on the arrow to the left of the
Densities or Static Probes heading if this portion
of the window is not displayed.
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The values displayed in the “Before” are only updated
after the screen has been updated, either manually or
automatically. The values displayed in the “After” are
updated when a change is made to a control in the PE
RGB controls.

Using the PE RGB Controls

All of the color correction tools for the RGB color space
are found in the PE RGB Control window. To open this
window, select any of the options on the Correction
menu.

The PE RGB Control window includes four tabs to access:

Tone & Cast

Color

Histograms

ColorSync

Click on a tab to select the corresponding option on the
Correction menu. Each is described in the remainder of
this chapter.

Figure 4–2
PE RGB Control
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Tone & Cast:  Adjusting Tonal Range
One of the most important tasks in producing good quali-
ty scanned images is setting the tonal range. This can be
done four different ways:

Using Trident’s Auto Range feature.

Using the highlight and shadow eyedropper.

Adjusting the tone curves manually.

Manipulating the histograms (as described in the fol-
lowing section).

Note: Every original, film or print, has a specific
density range which defines the points where
the image data starts and ends. This density
range is measured on an optical density scale of
0 (lowest) to 4 (highest).

Setting the Tonal Range Automatically

The best way to set the initial tonal range of an image is
to click on the Auto Range button ( ) on the button bar
or in the Tone & Cast section of the PE RGB Control win-
dow.

Note: When using the Auto Range feature, be
sure to crop the image so that no film edge or
clear drum/platen surface is included within the
crop boundaries. These “non-image” pixels
could distort the range.

The output value edit fields, located next to the Auto
Range button, are used to define the RGB values in the
final image data for highlight and shadow. Values entered
in these fields will be used by the Auto Range and the
highlight and shadow eyedroppers.
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Setting Cast Correction

Cast correction is the process by which unwanted color is
removed from the desired neutral tones of an image.
Trident provides automated and manual controls to target
five points along the tonal range: highlights, quarter
tones, midtones, three-quarter tones, and shadows.

Cast correction is important because the PE separator per-
forms color correction separately on the hues and on the
neutral areas. Casts are removed by adjusting the Red,
Green, and Blue densities of a selected tonal region. By
making the output densities equal or nearly equal, the
result is a neutral value.

The “input range” defines where in the image the data
starts and ends. By making a Cast Removal (Highlight or
Shadow) selection at the bottom of the PE RGB Control
window you can control where the endpoints of the
curves are set:

When a Cast Removal option is selected for highlight
or shadow, color channels are treated individually,
setting the endpoints based on individual histograms.
Using this option automatically removes cast from the
lightest and darkest points in the image.

When a Cast Removal option is not selected, each
channel’s endpoints are set to the density of the light-
est and/or darkest points in the image. 

Note: When scanning in RGB mode with Cast
Removal turned off, you can only enter a Red
value for Highlight and Shadow; the Green and
Blue values are set to the same value as Red.

Note: Many images may not contain truly
“neutral” points. For these images, it is best to
perform the following procedure on a grayscale
step wedge mounted next to the image instead
of the image itself.
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Using the Eyedropper

To correct casts automatically in the highlights, shadows,
or neutral grays:

1. Click on the appropriate eyedropper.

2. Move the cursor inside the image or step wedge and
click on the point you want to define. After you select
the point, the eyedropper tool is automatically dese-
lected.

3. Check the new values using the Probe.

The gray eyedropper can neutralize any point that is
selected with it.

Note: The gray eyedropper is unique in that it
can set multiple points. Gray points are made
up from the quarter tone, midtone, and three-
quarter tone regions.

Note for Mac Users Only:
To select multiple points, hold down the Option
key while selecting each point. Before you select
the last point, release the Option key and click
on the last point. The tool is then deselected
automatically.

Adjusting the Tone Curves Manually

The density range of an image can be set manually. This
is done by adjusting the gradation and/or RGB curves for
the image. To access the tonal curve, click on the arrow
to the left of the Tonal Curves heading. The tonal curve is
displayed, as shown in Figure 4-3 on the next page.
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Note: The purpose of tone and gradation is to
define neutral by removing unwanted casts and
to specify tone compression and contrast using
the gradation curve. Therefore, color correction
should be performed only in the Selective Color
window, where neutrals and hues are treated
separately. To adjust neutral tones, use Tone &
Cast; to correct hues, use Color.

Figure 4–3
Tonal Curves
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The “output density range” is usually set to different values
than the input range. The default output density value is
2.75, the maximum density monitors are capable of dis-
playing. Knowing the density range of your intended out-
put device and entering that value in the PE RGB Control
window helps optimize the quality of the final image.

Note: If you are unsure of which value to use,
keep the value 2.75. If your output device is a
film recorder, values of 3.0 or higher may be
advisable.

The gradation curve (black) defines how tone compression
is handled. The horizontal axis shows the input density
while the vertical axis displays the output density.

The points (called “anchor points”) are located, from left
to right, at the following values: highlights, quarter tones,
midtones, three-quarter tones, and shadows. By selecting
an anchor point and dragging it up or down, you can alter
the gradation value for that point.

The black lock icon at the bottom left-hand corner of the
grid is open by default. By clicking on it, you can lock the
anchor points on the curve. It also adds more points to
work with. This allows you to move the points individual-
ly without affecting the others. Locking anchor points is
useful for fine-tuning the gradation curve. With the points
locked you are able to create a curve that has negative
s l o p e s .

Note: Adjustments in the gradation curve
change the input-to-output tonal compression.
For example, moving the three-quarter tone
point down expands the shadow area of the
image by starting the three-quarter tone range
at a lower optical density.
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Histograms:  Manipulating the Histograms
Another way to set the tonal range is by manipulating the
image’s histograms. To do so, click on Histograms tab or
select the Histograms option on the Correction menu.

The horizontal axis on the histogram represents the stan-
dard 0-to-4.0 density range. The Histograms window dis-
plays:

Input Density
This input histogram can be adjusted to show all three
RGB channels together or each channel individually.
To adjust the limits, slide the white slider (highlight)
and/or black slider (shadow) to the desired position.

Output Reflectance
This is a static display that cannot be adjusted. It is
designed to show how your adjustments will affect
the image when output to a file.

Figure 4–4
Histograms
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Note: Minor adjustments to histograms have
strong results. Move the sliders in small incre-
ments to avoid distorting your range values
excessively. (Remember to update the image
regularly to view your changes.)

Color:  Adjusting Colors
The Color tab (Color option on the Correction menu) pro-
vides control over all levels of the chroma (saturated and
pastels) or just the low chroma (pastel).

Figure 4–5
Color
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This will enable you to correct each of the primary and
secondary colors independent of each other (as opposed
to the Global corrections found in the Tone & Cast menu).

The Color Selection color wheel can be toggled between
all chromas selection and a low chroma only selection.
Simply click on the color wheel to toggle between the two.

Correcting Colors

The checkbox in the Color Corre c t i o n section of the PE
RGB Control window toggles selective color on or off. The
default mode is O n.

Note: The Color Cor rection checkbox should
always be checked.

The sliders in the Color Correction section allow you to
perform color correction in the three separate color chan-
nels. To do so, proceed as follows:

1. Select the hue to adjust by clicking on the color wheel.

2. Click on the circular button of the desired color.

Note: Automatically select proper hue and color
on the wheel by selecting a point in the image
with the Probe tool (combining steps 1 and 2).

3. Adjust the sliders to add or remove color(s) in a chan-
nel. Remember that small movements in either direc-
tion can have strong effects.

Note: The boxes in each slider show arbitrary
reference numbers for your convenience. The
numbers to the right of the boxes show the RGB
values after the change.

4. Click on the Manual Update button in the window to
check the results of each change (or turn on automat-
ic updating by clicking on the Auto Update On button
in the tools).
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The Before and After sections of the Probe provide real-
time feedback for your changes.

ColorSync:  Using the ColorSync Feature (Mac Only)
The ColorSync window appears (as shown in Figure 4-6)
when you click on the ColorSync tab or select the
ColorSync option on the Correction menu.

ColorSync is a method used to calibrate the input device
(scanner), display device (monitor) and output device
(imagesetter, printer, film recorder, etc.) to the same inde-
pendent color space for accurate display and output.

Note: For the best results when performing an
Auto Range with ColorSync, turn off Cast
Removal on the Tone & Cast dialog.

The ColorSync feature enables you to view the prescanned
image data on the monitor as calibrated data and scan an
image into a different color space (such as RGB to CMYK
conversion). This feature utilizes the Apple ColorSync

Figure 4–6
ColorSync
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Color Management Architecture which is based on the
International Color Consortium (ICC) device independent
profiles. The Trident ColorSync feature enables you to
pick an Input Profile, Output Profile, and Display Profile.

Note: You must have ColorSync 2.0 or later
loaded in your Mac OS to use the ColorSync
Menu in Trident.

Generic profiles can be supplied by the device
vendor or you can create custom profiles using
many third party software packages.

These device profiles must be installed into the
ColorSync Profiles Folder, found in your Mac
System folder, for Trident to find them.

Select Input Profile
Displays all the input device profiles that are loaded in
your ColorSync Profiles Folder. Several reflective and
transmissive profiles for each scanner are available
from Howtek. Pick the profile that you would like to
apply to the image data.

Select Output Profile
Displays all the output device profiles that are loaded
in your ColorSync Profiles Folder. If you select a CMYK
Output Profile, Trident will generate a scanned image
as a CMYK TIF file.

Select Display Profile
Displays all the output device profiles that are loaded
in your ColorSync Profiles Folder.

Store ColorSync Profile in Saved Images
Embeds the profiles into the scanned image TIFF
header. This will allow them to be read by other soft-
ware applications later.

You can press the Update button to view the effects of
each profile on the image data once it has been selected.
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Using Line Art Controls

All of the color correction tools for line art are found on
the Line Art tab of the PE RGB Control window. To open
this window, select the Line Art option on the Correction
menu or pick one of the line art options on the Scan
Mode pull-down menu (in the Trident tools).

The Line Art window is divided into three sections:

Input Density
Displays an input density histogram for the line art.
The input density will display the histogram for the
color channel that you selected on the Scan Mode
pull-down menu (in the Trident tools).

To adjust the limits, slide the white slider (highlight)
and/or black slider (shadow) to the desired position.

Figure 4–7
Line Art
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Percent Threshold
Sets the percentage threshold for the line art. By mov-
ing the slider, you can adjust the percentage. The
threshold determines which pixel values will be white
(255) or black (0).

Line Art Scan Preferences
Sets preferences for line art. Note that unsharp mask-
ing and descreening are described in Chapter 5.

Saving and Recalling Settings

During your color correction work, you may decide to
save the changes you have made for future applications.
You may also wish to use other predefined settings, or
even start over. Trident gives you the option of saving
and recalling default or previously saved settings for one
or all of the parameters you have changed.

To use this feature, select one of the options on the
Settings menu:

Save
Saves custom correction settings. In the Settings win-
dow, check off the settings you want to save.

Then, name the settings file and choose where it will
be stored. The settings now can be recalled any time
using the Recall feature (see next page).

Figure 4–8
Settings
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Note: Only the settings you check off are saved.

Recall
Recalls a previously saved settings file. You may recall
a settings file you created. After you initiate the recall
procedure, a standard file window appears for you to
select the settings file to be recalled.

Save Default
Stores your own custom default settings.

Note: The Save Default option overwrites
Trident’s default settings. Once Trident’s defaults
have been overwritten, they cannot be recalled.
If you use certain settings regularly, save those
settings in a separate file and recall them as
needed. See Save and Recall above for more
information about these options.

When you select Save Default, a window similar to the
one shown in Figure 4-8 appears where you can
check off the settings to be saved as defaults.

Note: Only the settings you check off are saved
as defaults.

Recall Default

Enables you to select the specific default settings to
be recalled by clicking on the appropriate checkboxes
in the Settings window. Click on OK to recall the set-
tings.  You can quickly get to this window by clicking
on the Recall Default button, shown above, the is
found at the bottom of the button bar.

Reset to Factory Defaults
Resets any or all correction values to the factory set-
tings. This option is useful if you have made too many
corrections to your image and wish to start again.
These settings cannot be edited.
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Note: In some cases, Trident grays out settings
in the Settings window when the Recall Default
and Reset to Factory Defaults options are
selected. The grayed out items are values which
have not been saved.



Unsharp Masking,
D e s c reening, and
L*a*b Corre c t i o n
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Trident offers many powerful features that allow you to
correct your prescanned images before final scanning.

This chapter describes Trident’s:

Unsharp Masking (USM)

Descreening

L*a*b Correction

Applying Unsharp Masking

Unsharp masking (USM) represents a way of adjusting the
contrast of edge detail in an image.

To use the UnSharp Masking feature, select the USM
option on the Tools menu. Additional options are provid-
ed:

Light

Moderate

Heavy

Custom

If you select L i g h t, M o d e r a t e, or H e a v y, Trident automati-
cally adjusts the contrast of edge detail to the degree indi-
cated by the option name.

The C u s t o m option opens the UnSharp Masking window
(shown in Figure 5-1) which contains extensive tools for
fine-tuning the sharpness of your images.

You can toggle Unsharp Masking on or off by clicking on 
the On box next to UnSharp Mask at the top of the
UnSharp Masking window.

Note: Unsharp Masking is set to On by default.
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As with all of Trident’s image correction features, USM
allows you to recall previously saved settings, apply
defaults, or save new tables. All of these functions are
found in the Settings menu, as described in Chapter 4.

Figure 5–1
Unsharp Masking
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Using the Median Filter
The Median Filter is included to assist the USM function.
It helps to smooth out or reduce noise in the image.
When the Median Filter is selected, Trident will smooth
out the noise in the image before it applies the USM
selections to the image.

This can be very helpful with some images such as high
speed grainy film or mat-finish reflective prints.

Note: This smoothing of the noise will appear
to make the image look softer.

Controlling USM in Tonal Regions
Trident’s USM controls allow you to regulate the amount
of unsharp masking applied to each of your image’s tonal
regions. The Region Control chart in the UnSharp Masking
window shows the five tonal regions in the image from
left to right: highlights, quarter tones, midtones, three-
quarter tones, and shadows.

Note: The values used in the UnSharp Masking
window are arbitrary numbers for relative refer-
ence only.

The vertical axis of the Region Control chart is composed 
of non-editable percentages of sharpening to be applied.
The horizontal axis represents the 0-to-4.0 density range.
It contains five editable fields to define the percentage at
which each tonal region begins.

Note: The currently active region in the chart is
indicated in red.

Various fields in the USM window determine how the
tonal regions are handled. These are defined as follows:
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Sharpen
Governs the amount of sharpening applied to the
selected tonal region. To define a desired sharpening
value for a region, click on the region’s bar in the
chart (it turns red) and enter the value in this field.

Threshold
Refers to the minimum difference between dark and
light areas that must exist before unsharp masking is
applied. The lower the threshold value, the smaller
the difference between the pixel values needs to be to
apply USM. As you raise or lower the value in this
field, the active bar is shifted up or down in the chart
to reflect the higher or lower starting point for USM.
Areas below the threshold are smoothed (see below);
areas above it are sharpened.

Smooth
Evens out differences between tonal regions in an
image. This option is helpful, for example, in reducing
the effect of film grain (typically in the shadows or
three-quarter tones) when an image is magnified. A
higher Smooth value helps to diminish the film graini-
ness.

Smoothing is represented in the Region Control chart
by the lighter colored bar to the right of each dark bar.
As you increase the Smooth value, the lighter bar gets
longer, graphically representing the smoothing effect
between two adjacent regions.

Note: Only those areas below the threshold are
smoothed.
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Manually Adjusting the Region Control Bars

In addition to entering numerical values to adjust the
region control bars, you can manipulate the bars directly:

To adjust sharpening in a tonal region:
Click and drag the desired bar up or down.

To adjust sharpening in all tonal regions:
Hold down the Option (Mac) or Alt (PC) key and click
and drag any bar to the desired point. The region con-
trol bars move together.

To adjust smoothing in a tonal region:
Hold down the Shift key and drag the desired bar up
or down.

To adjust smoothing in all tonal regions:
While holding down the Option (Mac) or Alt (PC) key
and the Shift key, drag any bar up or down. The
smoothing bars move together.

To adjust the threshold of a tonal region: 
Hold down the Control key and drag the desired bar
up or down.

To adjust the threshold of all tonal regions:
Hold down the Control key and Option (Mac) or Alt
(PC) key and drag any bar up or down. The bars move
together, maintaining their relative sharpening and
smoothing positions.

Controlling Edges Between Tonal Regions

Trident’s unsharp masking also allows you to choose
luminance, monocolored edges, or colored edges to
sharpen.

Luminance
The lightness and darkness detail in the image.

Mono Edges
Edges made up of a single color, mixed in the ratio
you define in the R, G, and B fields.
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Color Edges
Edges which are a composite of the surrounding colors.

The edge setting is a matter of individual preference.
Some images tend to look better with mono edges (also
called “halos”). The goal is to achieve the right amount of
edge sharpening without overaccentuating the halos.

Controlling Sharpening in Light and Dark Edge Areas

The Filter Control section in the UnSharp Masking win-
dow allows you to select or deselect sharpening in light
edge and dark edge areas. Trident’s default is “on” for
both settings.

Deselecting Light Edges tends to bring out dark edges and
detail and vice versa.

Using the Unsharp Masking Curve
The curve at the bottom of the UnSharp Masking window
graphically depicts the transition from gray to white in
unsharp masking.

Shape
Governs how quickly the colors ramp from gray to
white.

Radius
Measures how many pixels will be modified or how
wide the halo effect is at the edges of the tonal regions.

As you change these values, the curve at the left changes
shape.
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Applying Descreening

Descreening represents a method of eliminating the
moiré patterns that can result when printed halftone
images are scanned. The Descreening function can also
be useful in eliminating other artifacts, such as film grain.

To access Trident’s descreening function, select the
Descreening option on the Tools menu. The Descreening
window is displayed, as shown in Figure 5-2.

Descreening Options
The type of descreening to be applied is selected in the
top half of the Descreening window. The available options
are defined as follows: 

Of f
No descreening is used (default).

Coarse
The image is substantially descreened. Scanning in
this is generally used for material printed at a line
screen of 100 or lower.

Figure 5–2
Descreening
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Medium
Some descreening takes place. Scanning in this is
generally used for material printed at a line screen of
133 to 150.

Fine
Only a small amount of descreening occurs. Scanning
in this is generally used for material printed at a line
screen of 175 or higher.

Custom
This is used to set a specific line screen. Enter the lpi
value in the Line Screen field.

Customizing the Descreening Function
The arrow to the left of the Custom Settings heading
opens an additional area of the Descreening window (as
shown in Figure 5-2). This is used for customizing
Trident’s descreening function. The options for cus-
tomization are:

S m o o t h n e s s
Performs the same function as the Smooth field in the
UnSharp Masking window (see above). The value
entered in this field is reflected in the USM window.

Final Scans Only
Applies descreening only to the final image to be
scanned, but not to any prescans.

Scale USM
Limits the degree of unsharp masking applied to the
final image. To use the option, click on the checkbox
next to Scale USM and enter the percentage by which
you want USM reduced.

Since descreening “softens” the focus of an image, the
Scale USM option is helpful because it helps to avoid
oversharpening” the image again by applying an
excessive amount of unsharp masking.
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Applying L*a*b Correction

L*a*b offers a different color space in which you can
work. It is a device-independent color space that enables
you to define color in 3-D space.

“L” stands for “Luminance” (brightness) and is equiva-
lent to the Z-direction in 3-D color space. It indicates
lightness and darkness. The curve control can adjust
lightness, darkness, and contrast in the luminance
channel of an image.

“a” and “b” are chrominance (color) information and
are equivalent to the X- and Y-directions in 3-D space.
They define color and enable you to shift the hue of
the entire image. 0,0 is neutral.

Figure 5–3
L*a*b Color Correction
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The “a” channel ranges from green to magenta.
The “b” channel ranges from blue to yellow.

To access the L*a*b correction feature, select the L*a*b
Correction option on the Tools menu. The L*a*b Color
Correction window is displayed, as shown in Figure 5-3.
From the Channel pull-down, choose the Luminance, a, or
b channel to correct.

When the L*a*b Correction Enabled box is checked, the
data will be displayed and applied to the image data. To
view the corrections made in the L*a*b color menu,
check this box, make your change, and then select the
Update button ( ) on the L*a*b Color Correction dialog.

Note: The Auto Update feature does not apply
to this menu.



Color Correction in
the CMYK Color
Space: Pro d u c t i o n
M o d e
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Trident’s SE package offers two color control modes for
image correction work in the CMYK color space:

Production Mode, as described in this chapter.

Expert Mode, as described in Chapter 7.

This chapter explains how to use Production mode and
covers the following topics:

Understanding the SE Probe

Using Production Color Controls

Making Selective Color Corrections

Accessing the Production Mode

To access the Production mode:

1. Select Preferences on the Edit menu. The Preferences
window is displayed (as described in Chapter 2).

2. Select Production as the SE Separator Mode on the
Preferences window.
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Understanding the SE Probe

Open the SE Probe window by selecting P ro b e on the To o l s
menu. (Mac users can press the Command and P keys).

The Probe is a static display of numerical information
used as a guide in making color correction changes. It is
a valuable tool and should always be used in conjunction
with the screen display. This section explains how to
understand and use the Probe’s parts.

Probe Location
This section of the SE Probe window shows the cursor’s
X/Y coordinates at the current location.

Displaying Density Values
The D e n s i t i e s table can be toggled open or closed with the
blue triangle. It displays the RGB densities as read from the
scanner (Original), after color correction (Reproduction),
and when output after tone compression (Output).

Figure 6–1
SE Probe Window
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Displaying Color Plates
The Probe allows you to select the color separations or
combination of separations you would like to view in the
image window as follows:

The Four Plates button ( ) shows all four process
colors together in the image window.
(Mac users can press the Command and 0 keys).

The Cyan button ( ) shows only the Cyan plate in
the image window.
(Mac users can press the Command and 1 keys).

The Magenta button ( ) shows only the Magenta
plate in the image window.
(Mac users can press the Command and 2 keys).

The Yellow button ( ) shows only the Yellow plate
in the image window.
(Mac users can press the Command and 3 keys).

The Black button ( ) shows only the Black plate in
the image window.
(Mac users can press the Command and 4 keys).

CMYK Values Before and After Corrections
The section below the Color Plates shows the CMYK val-
ues of the current cursor location before and after
changes, both in color swatches and in terms of dot per-
centages.

Note: As you sample the image, you can click
your mouse to “mark” a location for image cor-
rection. The CMYK values for that location are
then entered in the SE Selective Color window
(see below for details) and remain there until
you click on another location in the image win-
dow. After a location is marked, the cursor can
still be used to sample other parts of the image.
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Selecting Fixed Reference Points
The Static Probes section at the bottom of the SE Probe
can be toggled open or closed by clicking on the blue tri-
angle. This enables you to select up to three fixed points
in the image which you can use to monitor important
tonal ranges as you correct the image.

To select a point, click on the 1, 2, or 3 button and click
on the desired location in the image. The location is
flagged with the number, and the colors and dot percent-
age values for that point before and after any changes are
displayed in the Probe.

Note: New static points can be selected at any
time using the above procedure, but the points
cannot be moved or deleted.

Using Production Color Controls

Trident SE Production mode is designed to combine the
most common tools for color correction work in a single
dialog window. This enables you to work more efficiently,
gain a better overview of all adjustments, and use win-
dow space economically. For more detailed and precise
color controls in the CMYK color space, or to build cus-
tom tables, use the Expert mode (see Chapter 7).

Note: Changes made in Production mode are
reflected in the individual controls in Expert
mode and vice versa.

Open the Production Controls window by selecting
Production Controls on the Correction menu.
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Setting Highlight and Shadow Limits
Setting highlight and shadow values accurately is one of
the most important steps in correcting scanned images.
The task can be performed manually or using Trident’s
Auto Range feature (see below and on the next page).

Note: The “sticky densitometer” shows high-
light and shadow on the image.

Highlight
This number is the original density for specular high-
light (whitest white) or diffused highlight (0=clear,
4=maximum density).

Auto Range
This button sets the white point (highlight) and black
point (shadow) automatically.

Shadow
This number is the original shadow density.

Figure 6–2
Production Controls
Window



6-6 Trident User Guide

Manually Setting Highlights and Shadows

Use the Highlight and Shadow boxes at the top of the
window to set the original (input) density of the scanned
image. The density values, which range from 0.0
(Specular Highlight) to 4.0 (Shadow), instruct Trident as to
when to start and stop recording image data. To set a
specular highlight and shadow limit manually, enter the
desired values in these boxes. (For more information on
specular highlights, see the section Specular vs. Diffused
Highlights on the next page.)

Automatically Setting Highlights and Shadows

An image’s input range can also be adjusted automatical-
ly using the Auto Range button ( ). Click on this button
to apply a histogram of the density values in the cropped
area to set the highlight and shadow density limits.

Using the Eyedroppers to Correct Color Casts
Cast correction is the process by which unwanted color is
removed from the neutral tones of an image. Trident pro-
vides automated and manual controls to target five points
along the tonal range: highlights, quarter tones, midtones,
three-quarter tones, and shadows.

Changes occur based on settings in the Expert Mode, as
described in Chapter 7 (refer to the section titled, Using
Tone & Cast Controls).

Cast correction is important because the SE Separator per-
forms color correction separately on the hues and on the
neutral areas. Casts are removed by adjusting the Red,
Green, and Blue densities of a selected tonal region. By
making the output densities equal or nearly equal, the
result is a neutral value. This neutral density value is
passed through Tr i d e n t ’s gray balance table where the
appropriate dot values are applied.
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Note: Many images may not contain truly
“neutral” points. For these images, it is best to
perform the following procedure on a grayscale
step wedge mounted next to the image instead
of the image itself.

To correct casts automatically in the highlights, shadows,
or neutral grays:

1. Click on the appropriate eyedropper: Highlight (on the
left), Gray (in the middle), or Shadow (on the right).

2. Move the cursor inside the image or step wedge and
click on the point you wish to define. After you select
the point, the eyedropper tool is automatically dese-
lected.

3. Check the new values using the Probe.

Specular vs. Diffused Highlights

There are two types of highlights:

“Specular” highlights are areas that contain no dot
percentage of any ink.

“Diffused” highlights contain a minimum dot percent-
age.

All densities less than the diffused highlight slope to a 0%
dot at a 45° angle. This angle is often referred to as “catch
light” (as described in Chapter 7).

The values that will be set by the eyedroppers can be
modified on the Expert Tone & Cast window as described
in Chapter 7.

To set a specular highlight:

In order for a point to be “specular,” the C, M, and Y input
boxes next to the highlight eyedropper (on the Expert
Tone & Cast window) must contain 0 for each ink. Refer
to Chapter 7.
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To set a diffused highlight:

The factory defaults for Cyan, Magenta, and Yellow are
5%, 3%, and 3%, respectively. If you need to change these
values, use the Expert Tone & Cast window (described in
Chapter 7). In the C y a n box next to the Highlight e y e d r o p-
p e r, enter the Cyan dot value from the Probe. The
Magenta and Yellow value are automatically filled in.
These values are generated from Trident’s gray balance
table.

Removing Color Casts
Some images are intentionally photographed through
color filters, which, while adding artistic effects, also add
a color cast to the image. The human eye is extraordinari-
ly sensitive to shifts in colors in the neutral areas, so cast
removal from the highlights and shadows is of paramount
importance.

This is accomplished with the Cast Removal pull-down
menu in the Tone & Cast section of the SE Production
Controls window. Refer to Correcting Color Castsin
Chapter 7 for a complete description.

Using the Gray Eyedropper
Gray points are made up from the quarter tone, midtone,
and three-quarter tone regions. Gray is important for neg-
atives. The gray eyedropper is unique in that it can set
multiple points.

Note for Mac Users Only:
To select multiple points, hold down the O p t i o n
key down while selecting each point. Before you
select the last point, release the O p t i o n key and
click on the point. The tool is then deselected
a u t o m a t i c a l l y.
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Setting Dot Limits
Click the Dot Limits button on the Production Controls
window. The Dot Limits window is displayed. It is used to
control how inks will be output on a press.

The dot limit fields are defined as follows:

GCR (Gray Component Replacement)
UCR (Undercolor Removal)
Replace CMY inks with Black in the neutral areas to
reduce total ink on the press. GCR%/UCR% is the per-
centage of ink replaced, while Start% defines the cyan
dot percentage at which GCR/UCR begins.

Total Ink
Represents the maximum dot percentage the press
can accommodate and equals the sum of the CMYK
ink percentages. This number is generally between
260% and 340%.

Start GCR
Replaces CMY inks with Black in the neutral areas to
reduce total ink on the press. Start% defines the cyan
dot percentage at which GCR/UCR begins.

Max Black
Sets the maximum dot percentage for Black.

Start Black
Defines the Cyan dot percentage at which Black
begins to be added.

Note: It is always advisable to consult with your
p ress operator when adjusting ink contro l s .

Figure 6–3
Dot Limits Window
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Adjusting Brightness, Contrast, and Saturation
Brightness, Contrast, and Saturation sliders are available
on the Production Controls window.

Brightness
Sets the relative lightness or darkness of the color.
The Brightness slider represents the percentage of
brightness from 0% (black, at the leftmost register of
the slider) to 100% (white, at the rightmost slider reg-
ister).

Contrast
Sets the tonal range of the image (highlights, shad-
ows, and midtones) at the same time. The leftmost
slider register represents the lowest contrast while the
rightmost register is the highest contrast.

Saturation
Sets the strength or purity of the color. The Saturation
slider represents the amount of gray in proportion to
the hue and is measured as a percentage from 0%
(gray, at the leftmost slider register) to 100% (fully sat-
urated, at the rightmost slider register).
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Making Selective Color Corrections

The SE Selective Color window (see Figure 6–4) provides
control over high chroma (saturated) and low chroma
(pastel) in all primary and secondary colors independent-
ly. To open the window, select Selective Color from the
Correction menu.

Selecting Colors to be Corrected
Use the Color Selection color wheel to select the individ-
ual color to be corrected. You can also click on any area
of the image and Trident automatically detects the select-
ed pixel’s high value and whether it is a pastel or saturat-
ed color. To toggle between the high and low chroma col-
ors, click on the color wheel. This toggle feature allows
you to make changes in the darker or lighter colors with-
out affecting each other.

Figure 6–4
SE Selective Color
Window
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Using the Sliders to Correct Individual Colors
The sliders in the Color Correction section allow you to
perform detailed color correction. Follow this procedure:

1. Select the color to adjust by clicking the appropriate
radio button around the Color Selection color wheel.
Clicking on a point in the image automatically selects 
the proper hue.

2. Adjust the sliders in the desired color(s) to add or
remove CMYK inks for that color. Remember that
small movements in either direction can have sub-
stantial effects.

Note: The boxes in each slider contain arbitrary
reference numbers for your convenience.

3. Click on the Manual Update button in the window to
check the results of each change (or turn on automat-
ic updating by clicking the Auto Update On button in
the tools).

4. Check the Before and After swatches in the Probe to
evaluate the effect of the color change.
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Space: Expert Mode
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Tr i d e n t ’s SE package offers two color control modes for
your image correction work in the CMYK color space:

Production and Expert. The Production color control mode
was discussed in Chapter 6.

This chapter explains how to use Expert mode and cov e r s
the following topics:

Calibrating Trident SE

Setting up the gray balance

Controlling dot gain

Using gradation controls

Using tone controls

For information on how to use the SE Probe, see Under -
standing the SE Probe in Chapter 6.

Accessing the Expert Mode

To access the Expert mode:

1. Select Preferences on the Edit menu. The Preferences
window is displayed (as described in Chapter 2).

2. Select Expert as the SE Separator Mode on the
Preferences window.
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Calibrating Trident SE

CAUTION: Trident SE should be set up and cali-
brated only using the procedure in this section.
Do not make any adjustments in the SE Setup
window.

Understanding Calibration
Trident incorporates a user-friendly method of calibrating
the SE Separator for specific output devices, such as
inkjet printers, conventional proof printers, and printing
presses. The software includes a file called Trident 16,
which contains patches for saturated and pastel colors, as
well as a three-color and four-color Black patch (see
Figure 7–1). The markers A, B, and C outside the color
patches identify the orientation of the target and the loca-
tion of the patches.

Note: Trident calibration is only used with
printed targets, not film-based targets (e.g.
Q60). This calibration method characterizes
output devices, not films.

By characterizing the output device, Trident can automat-
ically remove unwanted contaminants found in inks (a
process sometimes referred to as “wanted” and “unwant-
ed” calibration). It also allows Trident to set the proper
thresholds between the saturated and pastel colors.

Figure 7–1
Trident 16 Target File
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The three-color Black patch sets the maximum three-
color density. This value is automatically entered into
Trident’s gray balance table and determines the endpoint
of the Grad 3 gradation curve. Similarly, the four-color
Black patch sets the maximum four-color density and
determines the endpoint of the Grad 4 curve.

Note: The Grad 3 and 4 curves can be viewed
only in SE Expert mode.

Preparing the Target for Output
Trident 16 is a CMYK file in TIFF format. In order to char-
acterize your output device properly, the file must be
processed exactly as a real job, so that all transforms and
screens are identical to actual production work.

To prepare the target file for output, follow these steps:

1. Output the Trident 16 file on film.

2. Produce a match print using your standard production
process.

Note: Make sure the match print is free of any
artifacts, such as scratches, ink spots, or finger-
prints.

3. Mount the print on the drum or platen surface of your
scanner.

4. Produce an Overview scan and preview scan a region 
containing the print. (For information on producing
Overview scans and working with regions, see
Chapter 3).

Note: The Scan Type must be set to Reflective.

5. On the Edit menu, select Selective Calibration. The
Selective Calibration window appears:
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6. Make sure the selected Target is Trident 16. If not,
select Trident 16 from the pulldown menu.

Note: Although it is possible to use customized
targets, it is strongly recommended that you
use the file supplied with Trident.

7. Click on Start. The Point A radial button becomes
active.

8. Move the cursor over the A patch on the target image.
The cursor changes to look like this: .

9. Click once on the A patch. The Found box for A is
now checked and the Point B radial button becomes
active.

10. Place the box over patch B and click once. The Found
box for B is checked and the Point C radial button
becomes active.

Figure 7–2
Selective Calibration
Window
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11. Place the box over patch C and click once. The Found
box for C is checked.

12. Click on the Calibrate button. The calibration takes
less than one second. The Selective Calibration win-
dow then returns to its original state (no points
found).

13. Save the calibration settings to a file. In the Save
Settings window, check off SE Color & Setup and SE
Gray Balance (for more information on saving settings,
see Chapter 2).

Note: Before saving settings as defaults, use
the settings and verify that they produce the
expected results. It is also advisable to save
existing defaults before defining new ones.

Setting Up the Gray Balance

Tr i d e n t ’s Gray Balance table should be adjusted for each
press environment you intend to use. Trident provides a
number of easy-to-use tools for customizing tables for dif-
ferent ink or printing conditions. To bring up the SE Gray
Balance window (see Figure 7–3) select Gray Balance o n
the C o rre c t i o n m e n u .

The gray balance table shows the corresponding Magenta
and Yellow values for Cyan dot percentages in increments
of 5%. Depending on specific press characteristics, you
might, for example, want to make sure that at a 50% Cyan
dot, the Magenta channel is not too strong. This table
could be used to reduce the Magenta value to, for exam-
p l e, 39% by typing 3 9 in the M a g e n t a field at Cyan 50%.

Note: SE Gray Balance affects only the repro-
duction of the neutral areas. It does not affect
the reproduction of hues.
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The default gray balance values for Trident are those for
SWOP inks and may vary with different ink manufactur-
ers. Ink values correspond to a given density, which is
used by Trident to determine the ink values to be used.

Trident’s Save and Recall features are very useful in the
SE Gray Balance controls, allowing you to store and reuse
different gray balance tables.

Figure 7–3
SE Gray Balance
Window
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Editing the Gray Balance Table
The Gray Balance table can be edited by entering the
desired values in the fields. This can be done using the
two different settings in the Points section as follows:

F e w e r
By selecting this mode, you can enter the desired val-
ues only in the 5%, 50%, and 100% fields for Magenta
and Ye l l o w. After entering the values, click on the
I n t e r p o l a t e, and Trident calculates all the values in
between those fields.

M o r e
By selecting this mode, you can enter values in all of
the fields in the table.

Controlling Dot Gain

Trident’s dot gain controls are accessed by selecting Dot
Gain on the Correction menu. The Dot Gain window that
appears (see Figure 7–4) contains a table of values with
dot percentages for the Cyan, Magenta, Yellow, and Black
inks.

Setting Dot Gain
Presses vary widely in terms of the dot percentages at
which they experience maximum dot gain. The four color
plates also tend to gain differently from each other.
Tr i d e n t ’s SE Dot Gain window allows you to take a given
p r e s s ’s gain characteristics into account in preparing your
image for output.

The Dot Gain table shows dot percentages in increments
of 5% with editable fields to set the gain at those percent-
ages in each of the four color channels. Dot percentages
are determined by the dot gain value a particular press
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experiences. This value is best determined in consultation
with your press operator.

The Dot Gain table fields function as follows:

Density
Defines the maximum density for each ink.

Figure 7–4
SE Dot Gain Window
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Position
Defines the dot percentage at which the press experi-
ences maximum dot gain.

Gain
Sets the amount of dot gain at the dot percentage
indicated under Position.

Note: For greater ease of customization, you
can enter precise values in any of the fields.

After entering values in the Position and Gain fields, the
Dot Gain table adjusts to reflect these values, ramping
down on both sides of the Position percentage. To under-
stand how to use Trident’s SE Dot Gain feature, see the
following example.

Trident’s powerful features allow you to customize and
save different tables for different presses. This is particu-
larly useful for trade shops that run a variety of presses
for different types of work. By recalling the desired tables
with Trident’s Recall feature, you can apply previously
calculated dot gains to all your new images without reen-
tering data.

An Industry Example

The press operator indicates that the press in
your shop gains 20% at a peak of 40% for
Cyan. In the Dot Gain window, proceed as
follows:

1. Click on the Cyan Position field.

2. Enter 40.0.

3. Press Tab to move to the Cyan Gain field.

4. Enter 20.0 and press Return.

Repeat this procedure for the other plates,
adjusting the numbers based on the informa-
tion from your press operator.
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Using Gradation Controls

Trident’s gradation is controlled in the SE Gradation win-
dow (see Figure 7–5). To open this window select
Gradation on the Correction menu.

When making gradation corrections in your image always
keep the SE Probe window open to monitor the changes
in numerical values (for more information, see
Understanding the SE Probe in Chapter 6).

Understanding Gradation
In a general sense, gradation governs how quickly colors
ramp from highlight to shadow. In the SE Tone & Cast
window (see the Using Tone Controlslater in this chapter),
highlight and shadow values are defined independently
for Cyan, Magenta, Yellow, and Black. In the SE Gradation
window, however, highlight and shadow are set for
groups of colors globally.

The SE Gradation window consists of a curve grid and a
table of editable fields (see Working with the Gra d a t i o n
Table later in this section). You may notice that only Cyan
appears to be represented in the table. Cyan is the most

Figure 7–5
SE Gradation Window
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representative of the colors which make up “Grad 3,” a
term designating the CMY curve. However, gradation
changes affect all colors.

Above the table is a set of four radio buttons (see Figure
7–5) to select the gradation curve to work on. The buttons
are defined as follows:

Grad 3
Activates the three-color (CMY) density curve, shown
as the uppermost blue curve in the graph. This curve
determines the shape of the three-color density grada-
tion curve and sets both the three-color input and
output range (see Setting the Input Range later in this
section).

Note: The endpoints of the Grad 3 curve re p re-
sent the CMY re p roduction density. This value is
set automatically during SE selective calibration
(see the section earlier in this chapter). Do not
modify this value unless you intend to limit the
Cyan dot. This value should never be incre a s e d
beyond the maximum three-color density.

Grad 4
Represents the increased density that can be achieved
by adding Black to CMY (also referred to as the
“skeletal Black”). The shape of the curve reflects
where Black begins and ends and the slope of its
ramp in between. The endpoint of the Grad 4 curve
represents the total reproduction density of all four
inks (generally ± 2.0 for coated stock). The area in
between Grad 4 and Grad 3 curves represents the
skeletal Black. Refer to Figure 7-6.
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By pulling the nodes of Grad 4 down to meet Grad 3,
the Black is eliminated in the density range where the
curves meet:

Black Generation: UCR/GCR
Activates the UCR (Undercolor Removal)/GCR (Gray
Component Replacement) curve. This curve allows
you to specify how much Cyan, Magenta, and Yellow
is replaced with Black in the neutral areas. The higher
the UCR/GCR percentage, the less total ink is used on
the press.

Black
Activates the Black density curve, with which you can
directly adjust the amount of Black ink to be used
along the tonal range of the image. This curve is auto-
matically set from the Grad 4 and UCR/GCR curves,
and does not need to be adjusted.

Figure 7–7
Skeletal Black Area.
➀–Grad 4 curve.
➁–Grad 3 curve.
➂–Skeletal Black.
➃–Black eliminated.

➂

➀

➁

➃

Figure 7–6
Skeletal Black Area.
➀–Grad 4 curve.
➁–Grad 3 curve.
➂–Skeletal Black.

➂

➀

➁
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Setting the Input Range
The horizontal axis of the graph in the SE Gradation win-
dow shows the original densities as read by the scanner
from the original image. The vertical axis represents
reproduction densities (those that will actually be printed
on the press).

To optimize the data from your input image, it is impor-
tant to set the input density range properly. Setting the
range too narrowly will cause “clipping” (conversion of
tones to white or black), while setting it too wide can
make the image appear washed out. Use the Probe to
determine the current range limits of your image.

The input range is represented as a range of 0–4 on the
horizontal axis of the SE Gradation graph. The Specular
Highlight and Shadow boxes under the graph show the
current range limits. New limit values can be set by enter-
ing them directly in the boxes or by dragging the end-
points of the three-color curve horizontally.

The image’s input range can also be adjusted automati-
cally using Trident’s Auto Range feature. To do so, click
on the Auto Range button ( ) at the bottom of the SE
Gradation window. This immediately adjusts the input
range limits to the values found in the currently cropped
area.

Note: Always crop the image before using Auto
Range. Because this function always works with
the data inside the crop boundary, any film
edge or drum/platen surface that is included
affects its accuracy.
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Working with Gradation Curves
The points on the curves (called “anchor points”) can be
moved up or down to change the gradation value at any
point. The anchor points of the currently active curve are
shown in red. To activate a different curve, click on the
desired radio button above the table to the right of the
graph (Grad 3, Grad 4, UCR/GCR, or Black).

The black lock icon at the bottom left-hand corner of the
grid is open by default. By clicking on it, anchor points on
the curve are locked into position so you can move each
of the points individually without affecting the position of
the others. Locking the curve also creates additional
anchor points allowing you to fine-tune the curve further.

Note: Changes in one gradation curve affect its
relationship to the other curves.

To illustrate how to work with gradation curves, consider
this example: Suppose your goal were to reduce the CMY
values in the quarter tones. You would proceed as follows:

1. Select the Grad 3 radio button.

2. Click on the quarter tone anchor point of the Grad 3
curve.

3. Drag the anchor point down and monitor the numeri-
cal values in the table.

Note: Very small changes in a gradation curve
shape can have dramatic effects.

4. Update your image using the button at the top of the
SE Gradation window (or turn on automatic updating).

5. Measure the density values in the image window
using the SE Probe.

6. Repeat steps 2 through 5 until you achieve the desired
result.
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Using Negative Slope Detection

At the top of the SE Gradation window is a section called
Negative Slope Detection. This feature is designed to limit
the movement of the anchor points for the Grad 3 and
Grad 4 curves, preventing you from creating an invalid
curve with a negative slope (which occurs when a point
on the curve goes above an anchor point).

Setting the desired curve shape may involve moving mul-
tiple anchor points. If a point has reached its maximum or
minimum slope and no longer moves, negative slope
detection is at work. It may then be necessary to adjust
another point on the curve so that the curve will move
freely again.

The default setting for negative slope detection is on
(checkbox checked). If the function is off, all anchor
points move freely, but if a negative slope is detected in
the Grad 3 or Grad 4 curve, the appropriate box is checked
in the Negative Slope Detection section. The image cannot
be updated or final scanned until the negative slope situa-
tion is corrected.

Working with the Gradation Table
The gradation table in the SE Gradation window repre-
sents ink coverage on the press in numerical terms. The
rows go from shadow values at the top to highlights at
the bottom. The columns performs the following function:

Reproduction Density
Shows the input density for the shadow point (top)
and highlight point (bottom) in increments of 1/8
tonal point.

Cyan Dot %
Shows the dot percentage for Cyan ink at each tonal
step. Since Cyan is the densest ink, this value is, in
effect, the maximum dot size.
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Total Ink
Shows the total dot percentage at each tonal step.
Total ink coverage is determined by Grad 4 and
UCR/GCR.

Note: Adjusting the UCR/GCR curve is a power-
ful means of controlling the total dot perc e n t a g e .

Cyan Dot After UCR/GCR
Shows the maximum Cyan dot percentage after the
current UCR/GCR curve is applied. This column is
useful in determining how UCR/GCR affects ink
usage.

Black Dot %
Shows the dot percentage of the Black ink at the vari-
ous tonal steps. These values are affected by adjust-
ments in UCR/GCR, as well as changes in the shape
of the four-color or Black ink curves.

To understand the table read across a row. For example,
for the table shown in Figure 7–8, the top row (shadow)
indicates that at a reproduction density of 1.308, and a
total ink coverage of 320%, a 100% Cyan dot is reduced by
GCR to 80% and the maximum Black dot is at 100%.

The Gradation table is useful for entering values specific
to your requirements or production needs.

Note: Changes made in the SE Gradation
window in Expert mode are reflected in the
Production Controls window in Production
mode.
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Determining Black Generation
The method of Black generation can be set to UCR or
GCR by selecting the desired radial button at the bottom
right of the SE Gradation window. Which method is used
is a matter of individual preference, but the shape of the
curves can vary considerably between the two, with the
corresponding different effects on the image.

Note: Always refer to the Probe as well as a
standard gray step wedge to verify that you are
getting the desired results.

Using the Gradation Lock feature
The lock button located in the upper right hand side of
the Gradation menu locks the Grad 4, GCR or UCR and
Black Dot % together.  With the lock ON the Total Ink
value can be set and the software will calculate the other
two colums.  

Figure 7–8
Gradation Table
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Using Tone & Cast Controls

Trident’s tone controls in Expert mode are accessed by
selecting Tone & Cast on the Correction menu. The SE
Tone & Cast window (see Figure 7–9) provides a highly
flexible tool to correct color casts in your image.

When making tone corrections in your image always
keep the SE Probe open to monitor the changes in
numerical values (for more information, see Understand-
ing the SE Probe in Chapter 6).

Figure 7–9
SE Tone & Cast
Window
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Tone Curves
The primary tools in the SE Tone & Cast window are the
tone curves. They are a powerful way of correcting casts
in very specific tonal regions of your image. The C M Y K
radio buttons above the curves activate the Cyan, Magenta,
Yellow, or Black curve in the graph, respectively.

The horizontal axis of the graph shows the percentage of
reproduction density (the density that will actually be
printed on the press). The vertical axis represents the per-
centage of output density.

The points on the curve (called “anchor points”) are, from
left to right, located at the following values: highlights,
quarter tones, midtones, three-quarter tones and shad-
ows. By selecting an anchor point and dragging it up or
down, you can alter the amount of the selected color in
that tonal region.

Note: For more precise work, you can enter
density values for each anchor point on the
selected curve in the numerical fields to the
right of the graph.

The black lock icon at the bottom left-hand corner of the
grid is open by default. By clicking on it, the anchor points
on the curve are locked into position so you can move each
of the points individually without affecting the position of
the others. Locking the curve also creates additional
anchor points allowing you to fine-tune the curve further.

Correcting Color Casts
Cast correction is the process by which unwanted color is
removed from the neutral tones of an image. Trident pro-
vides automated and manual controls to target five points
along the tonal range: highlights, quarter tones, midtones,
three-quarter tones, and shadows.
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Cast correction is important because the SE separator
keeps hues and neutrals separate so that color correction
can be performed on the hues without affecting the neu-
tral areas. Casts are removed by adjusting the Red, Green,
and Blue densities of a selected tonal region. By making
the output densities equal or nearly equal, the result is a
neutral value. This neutral density value is passed through
Trident’s gray balance table where the appropriate dot
values are applied.

Note: Many images may not contain truly
“neutral” points. For these images, it is best to
perform the following procedure on a grayscale
step wedge mounted next to the image instead
of the image itself.

To correct casts automatically in the highlights, shadows
or neutral grays, proceed as follows:

1. Click on the appropriate eyedropper.

2. Move the cursor inside the image or step wedge and
click on the point you wish to define. After you select
the point, the eyedropper tool is automatically dese-
lected.

3. Check the new values using the Probe.

Specular vs. Diffused Highlights
There are two types of highlights: “Specular” highlights
are areas that contain no dot percentage of any ink, while
“diffused” highlights contain a minimum dot percentage.
All densities less than the diffused highlight slope to a 0%
dot at a 45° angle. This angle is often referred to as “catch
light.” (For more information on catch lights, see the sec-
tion Controlling Catch Lights below).
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To set a specular highlight:

1. Select the highlight eyedropper.

2. Move the pointer around the image or step wedge to
find a specular highlight point with the mouse.

Note: In order for a point to be “specular,” the
C, M, and Y input boxes next to the highlight
eyedropper must contain 0 for each ink.

3. Click on the desired point to set the specular highlight.

To set a diffused highlight:

1. Probe the image or step wedge to find the desired
point.

2. Select the Diffused Highlight eyedropper.

3. Move the eyedropper around the image or step wedge
to locate the desired highlight.

4. Click on the selected point.

5. In the Cyan box next to the Diffused Highlight eyedrop-
per, enter the Cyan dot value from the Probe. The
Magenta and Yellow values are automatically filled in.
These values are generated from Trident’s gray bal-
ance table.
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Controlling Catch Lights
The SE Tone & Cast window contains a section for con-
trolling the treatment of catch lights. With catch light con-
trol, the tone curves are scaled to the proper percentage
of the input range.

Note: When the Cast Correction eyedroppers
are used, the catch light control function is auto-
matically deactivated.

If the Auto Highlight and/or Auto Shadow option are
selected, the highlight and shadow values (to the right of
the eyedroppers) are used as defined.

If the Auto Highlight and/or Auto Shadow option are not
selected, the highlight is set to 0% and the shadow is set
to maximum range (100%).

The Catch Light Control section also enables you to define
the angle between the diffused highlight and the specular
highlight. The default setting for Angle is 45°.

Removing Color Casts
Some images are intentionally photographed through
color filters, which, while adding artistic effects, also add
a color cast to the image. The human eye is extraordinari-
ly sensitive to shifts in colors in the neutral areas, so cast
removal from the highlights and shadows is of paramount
importance.

Note: Removing too much of a cast from a
heavily casted image may cause undesirable
effects.

The Cast Removal pull-down menu at the bottom of the
SE Tone & Cast window allows you to set automatic cast
removal for the highlights and shadows as follows: Full,
Half, Manual, or None. By selecting Manual cast removal,
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you can define the density values or dot percentages for
highlight and shadow on the Cyan, Magenta, and Yellow
plates in the appropriate editable field or by selecting the
curve you wish to edit and moving the highlight or shad-
ow anchor point up or down.

Note: Click on the Dot % or Density radio but-
ton to display values in those units.

Using the Gray Eyedropper
The G r a y eyedropper is unique in that it can set multiple
points. Gray points are made up from the quarter tone,
m i d t o n e, and three-quarter tone regions.

Note for Mac Users Only:
To select multiple points, hold down the O p t i o n
key down while selecting each point. Before you
select the last point, release the O p t i o n key and
click on the point. The tool is then deselected
a u t o m a t i c a l l y.

Using the Setup Option

When working in Expert Mode, the Setup option is avail-
able on the Correction menu. This option opens the SE
Setup window which is used to define RGB to CMY con-
version, ink impurities, and maximum ink densities. This
table has been set up for SWAP standards. They will be
modified automatically when performing SE Selective
Calibration (from the Edit menu).

WARNING: These controls are very sensi -
tive and should be used only by an individ -
ual with in-depth knowledge of color sepa -
ration and inks.
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The Max Density field at the bottom of the SE Setup win-
dow represents the maximum three-color neutral density.
This value should be obtained from your press operator
or by performing a Selective Calibration using the Trident
16 target (described earlier in this chapter).

Note: Many software functions use the Max
Density value in the SE Setup window. It is
important in characterizing the print media (e.g.,
coated, uncoated, newsprint, etc.).
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to Disk
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Once you have completed color correction work on
your images, they are ready to be scanned to disk.

This chapter describes how to check final settings and
scan your corrected images to a file. This includes:

Reviewing scan settings.

Performing final scans.

Reviewing Scan Settings

Before final scanning, review your scanning parameters
to make sure you have made all necessary adjustments.

Note: Review the parameters for each region
individually. Make sure the desired region is
selected in the Queue Manager, as indicated by
the red frame around it.

Trident provides an overview of all scanning parameters
for a given region in the Scan Info window (select the
Scan Info option on the Tools menu). Figure 8–1 shows an
example of a Scan Info window.

The Scan Info window is a static display of the scanning
parameters. To make any changes before final scanning,
select the desired parameter options in the menu bar and
t o o l s .
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Checking Focus and Aperture (Drum Scanners Only)
If you are using a drum scanner, the Focus & Aperture
option on the Tools menu allows you to adjust the focus
and aperture settings of your scanner automatically or
manually.

Figure 8–1
Scan Info

Figure 8–2
Focus & Aperture
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The options work as follows:

Focus
Default setting for the focus is Automatic. To set the
focus manually, select Manual and move the Value
slider to the desired value. The last value picked by
the Automatic setting will remain.

Apertur e
Default setting for aperture is Automatic. Click on
Manual to select an aperture size from the Value pop-
up menu.

Checking Tool Parameters
Check the parameters in the tools to make sure they
match your final scan specifications.

Naming Final Scans
Final scan files are named using the default region name.
If you want to name the scans differently, before perform-
ing the final scan, proceed as follows:

1. Select the region in the Queue Manager by double-
clicking on it.

2. Select Save on the File menu.

3. In the standard file window that appears, enter the
name for the scan and click on Save.

4. Perform the final scan as outlined below.

Note: Final scan file icons in Trident are auto-
matically set to be opened in Adobe Photoshop™
when double-clicked. This feature is convenient
for perf o rming further image manipulations on
your final scans.

Figure 8–3
Toolbar Parameters
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Performing Final Scans

Once you have checked all your parameters and adjusted
your settings in a region, you are ready to final scan your
images. 

Scanning Images Individually
To scan a single region to disk, click on the Scan button
( ) under that region in the Queue Manager (or select
the Scan option on the Command menu). While the scan
is in progress, the button appears red, green, and blue.
After the region has been scanned, the Scan button turns
all red.

Batch Scanning All Images
Trident’s Queue Manager allows you to “final scan” all
regions in the Queue Manager in succession. To do so,
click on the Scan All button ( ) on the Queue Manager
or select the Scan All option on the Command menu. 

Note: Regions are scanned in the order they
appear in the queue. While scanning is in
progress, you may add regions, delete regions,
or rearrange the order of unscanned regions.
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Pausing or Stopping the Scanning Process: 
Mac Users Only
Once scanning has begun, you can stop the scan by
pressing the Command and period keys. Pressing these
keys during batch scanning will stop the scan for the cur-
rent image only. To interrupt the queue, click on the
green triangle under the Overview image in the Queue
Manager. The triangle will change to a red square.

To start the batch scan again, click on the red square
(which will then change to a green triangle).
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Figure 8–1
SE Setup Window
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This chapter offers some practical tips and hints for
your work with Trident. 

For additional information on trouble shooting be sure to
look at the FAQ section of the Howtek Web page at:
http://w w w. H o w t e k . c o m

Tips and Tricks

To hide the tools temporarily, select the Hide Toolbar
option on the Tools menu. To bring the tools back,
select the Show Toolbar option.

You can make the tools area into a floating window to
customize your use of monitor space. To do so, select
Unanchor Toolbar on the Tools menu. (To replace the
tools in its default position, select Anchor Toolbar.)

When adding regions, always define them in the
Overview window, not in another region.

To resize a region, change the Preview Size in the
Preferences window. This setting defines the dimen-
sions of the Overview window in pixels. Resizing the
Overview window itself does not change the region’s
dimensions.

Follow a rational naming scheme for your final scans
(by client, project, date, etc.). Otherwise, your hard
disk can quickly become cluttered with indecipherable
file names.

If you develop a group of settings that you use often
(for example in tone or gradation), save them as
tables using the Save option on the Settings menu to
speed up your work next time. See Chapter 3 for more
information.




